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Warranty and liability

Warranty and liability
Note

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
application examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.
We do not accept any liability for the information contained in this document.
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Any claims against us – based on whatever legal reason – resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.
Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of Siemens Industry Sector.

Security
information

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, solutions, machines, equipment and/or
networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.
For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept. Third-party
products that may be in use should also be considered. For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.
To stay informed about product updates as they occur, sign up for a productspecific newsletter. For more information, visit
http://support.automation.siemens.com.
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Preface

Preface
Objective of the Application
The objective is performance monitoring and diagnostics of control valves in the
context of SIMATIC PCS 7 plant asset management. A low-cost solution can be
achieved by intelligent combination and logical interpretation of measured process
values which are (mostly) already available in the DCS, in contrast to highend
condition monitoring systems based on dedicated additional sensors, e.g. vibration
sensors or structure-borne sound sensors.
Main contents
The following issues are discussed in this application:
How to implement valve monitoring.
How to parameterize and commission valve monitoring.
How to evaluate the monitoring results in the context of plant asset
management.
Validity
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Valid for PCS 7 V8.0 Update 1 and later versions.

NOTE

Please make sure you observe the notes of Condition Monitoring Library. Read
the notes carefully, because they contain information on installing and using
Condition Monitoring Library.
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1 Introduction Valve Monitoring
1.1 Area of Application

1

Introduction Valve Monitoring

1.1

Area of Application

Siemens AG 2014 All rights reserved

The PCS 7 Add-on product VlvMon offers a cost-effective solution for monitoring
and diagnosis of control valves, i.e. valves that can be fully or partially opened or
closed by continuous valve position control. Valve monitoring is based on an
intelligent combination and logical interpretation of measured process values which
are already available in the DCS. The VlvMon complements the self-diagnosis of
an electro pneumatic positioner, such as SIPART PS, or completely replaces this if
the positioner does not offer any self-diagnosis, or the self-diagnosis is not
integrated into the DCS.
Valves just like pumps are one of the most common actuators in process plants.
They are affected by different signs of wear and tear, such as wear (abrasion,
cavitation, corrosion) or fouling (material caking, build-up) on valve cone and/or
valve seat. The valve behaviour can be described by a static valve characteristic at
runtime. Valves are mechanical assets which are not registered as field devices in
the DCS by themselves, similar to pumps. Typically, they are driven pneumatically
and combined with an electro pneumatic positioner. The positioner as an intelligent
field device is already embedded into the asset management of the DCS. The
condition of the valves has a significant influence on the availability and safety of
the complete plant. The VlvMon permits a condition oriented monitoring of control
valves with different process values. Valve malfunctions and future valve failures
can be recognized early by this monitoring approach. This allows for an improved
maintenance planning and contributes to increase the availability of the complete
plant.
The function VlvMon is applied to
provide warnings against potential valve damage due to unfavorable operating
conditions or violation of wear limits: permanent operation without valve
standstill, permanent standstill, i.e. operating hours without any valve
movement inducing danger of material caking, violation of maximal number of
strokes, violation of maximal number of shifts in directions, violation of
operating hours limit.
provide early detection of developing valve degradation: material caking or
deposits, wear, monitoring of reaction times and flow characteristics.
optimize valve design in the long term by means of statistical analysis of
operating data: histogram of valve positions.
The VlvMon function block can be applied for any control valve which can be
opened/closed continuously. Binary switching valves (fully open/close only) are not
subject of this consideration. Only the basic condition monitoring (monitoring of
operating hours, valve standstill, etc.) is performed if the valve cannot read back
the actual valve position (valve position feedback). Control valves with position
feedback permit a check on valve movement errors (wear, material caking etc.). If
there are additional process values available which are typically measured in the
environment of valves, an extended valve diagnosis can be performed (monitoring
of the valve characteristic, the supply pressure etc.).
Relevant process values in the environment of valves:
flow rate of medium
valve intake pressure
valve outlet pressure
valve position setpoint
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1 Introduction Valve Monitoring
1.2 Functions
valve actual position (position feedback)
pressure of compressed air supply
Figure 1-1: P&I-diagram of valve with associated sensors and actors incl. valve monitoring
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The VlvMon function block does not include its own messaging, but can be linked
with PCS 7 standard messaging function blocks.
VlvMon can inform operators on any violations of the valve operating range and on
deviations from the expected characteristic, and make this data available for further
processing via the block outputs.
The block itself is designed purely for diagnostic purposes and, as such, does not
intervene directly in the operation of the control valve. This means that it can be
deployed, or even retrofitted, without the risk of affecting the process. If required,
active intervention can be achieved by evaluating the block outputs.

1.2

Functions
The VlvMon function block offers the following functions (literature /1/):
Analysis and graphical representation of characteristics of valve data and
operation states
Diagnostic functions for any control valve
Diagnostic functions for control valve with valve position feedback
Extended diagnostic functions with additional sensors
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1 Introduction Valve Monitoring
1.2 Functions

1.2.1

Analysis and Graphical Representation of Characteristics of Valve
Data and Operation States
Reference flow characteristic: display of reference flow as a function of valve
position with normalized flow (flow converted to norm difference pressure),
display of actual operating point and relative/absolute deviation of operating
point from reference characteristic line.
Actual flow characteristic: display of actual flow as a function of valve position
with normalized flow to detect drift, calculation of relative deviation of actual
flow characteristic from reference characteristic line.
Reference response time characteristic: display of reference valve response
time as a function of step height for positive setpoint steps only,
display of actual operating point and relative/absolute deviation of operating
point from reference characteristic line.
Actual response time characteristic: display of actual valve response time as a
function of step height for positive setpoint steps only to detect drift.
Histograms: statistical evaluation of valve operating states with respect to valve
positions.

1.2.2

Diagnostic Functions for any Control Valve
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The function block offers the following basic diagnostic functions for warning
operators in case of unfavorable operating states and reaching of wear limits.
These diagnostic functions do not identify any valve faults in the narrow sense.
These functions, however, help to prevent valve failures. They allow for an
improved maintenance planning and detect if a valve has exceeded its life cycle:
Monitoring of maximal operating hours in permanent standstill without any
valve movement
material caking, deposits, build-up.
Monitoring of maximal operating hours in permanent operation without valve
standstill
overload.

1.2.3

Monitoring of maximal number of strokes

maintenance.

Monitoring of maximal shifts in directions

maintenance.

Diagnostic Functions for Control Valve with Valve Position Feedback
The function block detects a faulty valve movement by the following diagnostic
methods. The setpoint provided by the positioner is compared to the real position
feedback of the valve. This way one can detect wear, build-ups, stiffness,
increased friction and other valve movement faults:
Detection of valve movements without setpoint demand
leakage.
Displacement of upper and lower end position
offset displacement.

compressed air

damage to valve cone, zero

Detecting of a steady state control error after end of valve movement
indication of drive problems or supply voltage problems.
Monitoring of valve response time with respect to a reference response time
characteristic
stiffness, damage of valve drive.
Monitoring of time period (dead time) which is needed by control valve to leave
a specified tolerance band (dead zone)
material caking, stiffness.
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1 Introduction Valve Monitoring
1.3 Typical Application Examples

1.2.4

Extended Diagnostic Functions with Additional Sensors
The function block offers the following extended diagnostic functions if additional
sensors are available, which are already installed in the environment of valves in
many cases:
Additional intake and outlet pressure sensor and flow sensor:
–

Monitoring of flow operating point with respect to a reference flow
characteristic as a function of valve position
indication of variation of
valve cross-sectional area (flow capacity) due to material caking or
abrasion.

–

Comparison of actual flow characteristic with reference flow characteristic
for a long-term drift detection
mechanical damage at the valve cone,
material caking, abrasion.

Additional compressed air supply sensor:
–

Siemens AG 2014 All rights reserved

1.2.5

Monitoring of air pressure

leakage in compressed air supply.

Teach Function
Point wise teaching of reference flow characteristic via coordinates of
interpolation points in reference state of the valve.
Point wise teaching of reference response time characteristic via coordinates
of interpolation points in reference state of the valve.

1.3

Typical Application Examples
Control valves that show malfunctions and signs of wear more frequently than
the average.
Control valves that are in danger of cavitation.
Control valves where chemical fouling occurs.
Control valves that show unaccountable variations with respect to reference
flow and response time characteristics.
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2 Implementation of Valve Monitoring
2.1 Installation of SIMATIC PCS 7 Add-on Product

2

Implementation of Valve Monitoring

2.1

Installation of SIMATIC PCS 7 Add-on Product
The installation of the PCS 7 Condition Monitoring Library (CML) is carried out by
the standard setup program.
The list bellow shows available combination of PCS 7 and Condition Monitoring
Libraries.
Table 2-1
PCS 7 version

CML version

Link

PCS 7 V8.0 Upd.1

Condition Monitoring Library
V8.0

http://support.automation.siemens
.com/WW/view/en/70081830

PCS 7 V8.0 SP1

Condition Monitoring Library
V8.0+SP1

http://support.automation.siemens
.com/WW/view/en/82647049

After installation the library is visible as "Condition monitoring" in the S7 library
catalogue.
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With the installation the manual and online help are integrated too.

2.2

Configuration
With respect to engineering, two completely different use cases are discussed:
retrofitting valve monitoring in a running plant, or greenfield engineering of the
complete automation around a control valve incl. valve monitoring.

2.2.1

Engineering of the Complete Automation (Based on Solution
Template)
Control valves are among the most frequent actuators in process plants just like
pumps. Around control valves, there is a typical combination of actors and sensors
that together with the valve provide the equipment module "control flow of a fluid
and monitor it".

Pump Unit
Since valves are frequently operated in combination with fixed speed pumps, the
valve is often already a component in the equipment module belonging to the
pump and therefore also a component of the Pump Unit (literature /2/). The typical
control and interlock functions which are required in the same way for all pumps as
well as the pump monitoring are part of the automation of the Unit. The valve
monitoring with the VlvMon function block can be implemented as an extension of
the Pump Unit.
In addition to the flow indication for the flow control, the pressure indications in front
of and behind the pump and the temperature indication of the liquid medium, a
pressure indication at the valve outlet is realized.
It is recommended to extend the solution template Pump Unit by valve monitoring
in the library part of the PCS 7 project.
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2 Implementation of Valve Monitoring
2.2 Configuration
Process Tag Type Flow Control
If there is already a control module type for flow control according to Figure 1-1 in
the project, it makes sense to integrate the VlvMon function block into this
template, because both valve position (=manipulated variable of flow controller)
and flow (=controlled variable of flow controller) are already available here.
Parameterization of Flow Controller based on Valve Characteristic and Valve
Transit Time
If the sensor time constant T1 of the flow measurement, the valve transit time Tm
(from end position to end position) and the valve characteristic (of which only the
maximal gradient K is relevant) are known from the VlvMon, the parameter of a PI
flow controller

K r ( s ) Gain (1

1
)
TI s

can be calculated beforehand, and a commissioning with the PID tuner is no more
necessary. The sensor time constant is typically specified by SIMATIC PDM at the
sensor. The valve transit time is measured by the positioner Siemens SIPART PS2
in the context of its controller self-tuning and is readable in PDM.
Controller parameters:
Siemens AG 2014 All rights reserved

Reset time TI= T1 (pole compensation)
Gain

Gain

5T1
(aperiodic limit case for a 20% step in valve position, typically
4Tm K

this value can still be intensified a little bit.)
Compensation of nonlinear characteristics
If the valve characteristic anyway is learned in the context of valve monitoring and
it shows a strongly nonlinear behavior, the control performance can be improved by
a compensation of this static nonlinearity by a polygon function block.
Note: Nonlinear operating characteristics which are relevant for control can appear
even in the context of “linear” valve characteristics according to the data sheet.

2.2.2

Retrofitting of Valve Monitoring in a Running Plant
In the following it is assumed that there is the basic automation around the control
valve incl. flow control already in the PCS 7 project.
The function block VlvMon is inserted in a CFC chart in the appropriate folder of
the technological hierarchy. Because VlvMon connects sensor signals from
different measurement tags, you will typically generate a new chart for it. This chart
can be located in the hierarchy folder to which the valve belongs, or in a separate
hierarchy tree "plant diagnosis". In this hierarchy tree similar to the PCS 7
maintenance station, target group specific information could be collected and
displayed. While the maintenance station is targeted to maintenance personal, the
target group for “plant diagnosis” are plant managers, process and control
engineers, who are responsible for optimizing plant operation.
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2 Implementation of Valve Monitoring
2.2 Configuration

2.2.3

CFC Engineering
The VlvMon function block is inserted into the designated CFC via Drag&Drop from
the block catalogue. The positioning of the function blocks in an OB (cyclic task) is
depending on the positioning of the related analogue driver blocks for process
values of pressure and flow. If the measuring of valve response times is urgently
desired, then the analogue driver blocks for process values and the VlvMon
function block should be inserted in the fastest possible OB. The other monitoring
functions (characteristics, operating hours etc.) are not critical in terms of real-time.
If the response times do not have to be monitored by the VlvMon, the function
block can be inserted in a slower OB (e.g. OB30) to save CPU resources.
The function block requires the following process values for control valves with
position feedback:
flow

input Flow [l/h]

valve intake pressure

input P_In [bar]

valve outlet pressure

input P_Out [bar]

valve position setpoint

input MV [%]

Siemens AG 2014 All rights reserved

valve actual position feedback

input Rbk [%] (feedback position)

For the extended monitoring with an additional sensor:
binary input variable for monitoring of compressed air supply
SuppPress

input

The process signals are linked with the related input variables of the analogue
driver blocks.
For the monitoring of the flow characteristic the flow must be independent of the
actual pressure conditions. Using the two pressure sensors in front of and behind
the control valve the flow is standardized to a norm pressure difference. Otherwise
a variation of the pump performance would cause the curve moving. The flow is
divided by the root of the difference pressure to obtain the normalized flow rate
FNorm (see formula 2.1).
Formula 2.1: norm flow

F

Norm

A

F ( A, p )
p

A

1
/2

F

Norm

normalized flow

F flow
A valve cross sec tion
p pressure drop
density
volumetric flow coefficient

For the automatic learning of valve characteristics the SteadyState function block is
required. The function block is provided together with the VlvMon function block in
the same library.
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2 Implementation of Valve Monitoring
2.2 Configuration
The SteadyState function block is applied to detect steady states in a dynamic
process. It analyses an input signal and decides without delay if this signal is in a
steady state or not. Further information is provided in the online help of the
SteadyState function block.
One instance of SteadyState function block is required for flow characteristic and
response time characteristic to be monitored. Each of them has to be connected in
the following way:
for flow characteristic:
Process value flow at analog driver block
input SteadyState.PV
output SteadyState.PV_Filtered
input ValveMon.Flow
for response time characteristic:
Process value feedback position at analog driver block
SteadyState.PV
output SteadyState.PV_Filtered
input ValveMon.MV

input

Figure 2-1: Linking of VlvMon function block in CFC
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Flow

Valve intake pressure
Valve outlet pressure

Valve feedback

Valve setpoint
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3 Parameter Specification and Commissioning
3.1 Required Data for Control Valve

3

Parameter Specification and
Commissioning

3.1

Required Data for Control Valve
The technical data listed in the following sections are required for configuration of
valve monitoring and have to be provided beforehand.

3.1.1

Data of Control Valve
Maximal number of strokes
Maximal number of shifts in directions
Maximal flow through the valve
Maximal standstill period without interruption
Maximal permanent movement period without interruption
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The VlvMon function block can automatically learn the flow- and response time
characteristic during operation. If this is not possible because no significant valve
movements are permitted in productive plant operation, the characteristics can be
taken from manuals and entered manually (see figure 3-1).

3.2

Parameter Input in Faceplate or CFC

3.2.1

Operating data of Control Valve
The basic operating data of the valve are displayed in the faceplate, view “Default”.
Figure 3-1: Operating data of Control Valve

Number of complete strokes
CFC)

StrokesMax (in faceplate, view „Default“, or in

Wear reserve of number of strokes
StrokesWearRes
(in faceplate, view „Default “, or in CFC)
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC

Number of shifts in directions
CFC)

SID_Max (in faceplate, view „Default“, or in

Wear reserve of number of shifts in directions
(in faceplate, view „Default “, or in CFC)
Standstill period without movement
or in CFC)

SID_WearRes

T_IdleMax (in faceplate, view „Default“,

Permanent (continuous) movement period without interruption
(in faceplate, view „Default“, or in CFC)

3.2.2

T_MoveMax

Parameters of Limit Values and Monitoring Tolerances
The parameters of monitoring tolerances and hysteresis areas are displayed in the
faceplate, view “Limit values”.

Siemens AG 2014 All rights reserved

Figure 3-2: Parameters of limit values and monitoring tolerances

Maximal deviation in [%] of the flow from the reference flow characteristic
FlowDriftTol (in faceplate, view „Limit values“, or in CFC)
Maximal deviation in [%] of the response time from the reference response
time characteristic
RespTol (in faceplate, view „Limit values“, or in CFC)
Minimal position feedback variation in [%], which can be interpreted as a valve
movement ("Movement")
MoveTol (in faceplate, view „Limit values“, or in
CFC)
Maximal tolerance in [%] of the valve position feedback relative to the valve
setpoint ("Final Position")
FinalTol (in faceplate, view „Limit values“, or in
CFC)
Minimal feedback change in [%] without setpoint demand by DCS ("External
movement")
ExtMoveTol (in faceplate, view „Limit values“, or in CFC)
Minimal tolerance area, which control valve must leave in order to detect a
valid valve movement ("Deadband")
DeadTol (available in a later version)
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC
Maximal number of strokes
or in CFC)

StrokesMax (in faceplate, view „Limit values“,

Maximal number of shifts in directions
values“, or in CFC)
Maximal flow through the valve

SID_Max (in faceplate, view „Limit

FlowMax (CFC only)

Maximal standstill period without interruption
„Limit values“, or in CFC)

T_IdelMax (in faceplate, view

Maximal permanent movement period without interruption
faceplate, view „Limit values “, or in CFC)

T_MoveMax (in

If the alarm limits are violated at runtime, the related binary outputs of VlvMon function
block are set to “true”. Limit violation of:
Number of strokes

StrokesMasAct = 1

Shifts in directions

SID_MaxAct = 1

Time without stillstand
Movement period
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Deviation of flow

T_IdleMaxAct = 1

T_MoveMaxAct =
FlowAct = 1

Deviation of response time open

RespUpAct = 1

Deviation of response time close

RespDnAct = 1

Tolerance area of valve position feedback relative to valve setpoint
CtrlDevMaxAct = 1
Change of valve position feedback without setpoint demand
1

ExtMoveAct =

Deadband monitoring is started by DeadActIn = 1 and shown by
= 1 (available in a later version))
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC

3.2.3

Parameters of Characteristic Lines
The flow and the response time characteristic respectively consist of 15
interpolation points. If the characteristics are available from the data sheet,
significant interpolation points can be listed in the faceplate, view “Parameter 1”.
The interpolation points are connected with each other by linear interpolation and
displayed in the faceplate.
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Figure 3-3: Interpolation points of flow characteristic, Parameter 1

Manual Parameter Input of the Flow Characteristic:
Interpolation points of valve position feedback (X-axis: [%])
VlvPos20(in faceplate, view „Parameter 1“, or in CFC)
Interpolation points of normalized flow rate (Y-axis: [l/h])
(in faceplate, view „Parameter 1“, or in CFC)

Flow1 ... Flow20

Maximal valve position feedback for scaling of the X-axis
faceplate, view „Parameter 1“, or in CFC)

VlvPosMax (in

Maximal flow rate for scaling of the Y-axis
„Parameter 1“, or in CFC)
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC
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Figure 3-4: Interpolation points of reaction time characteristic, Parameter 2

Manual parameter input of the response time characteristic:
Interpolation points of the step height close (X-axis: [%])
StepHiDn1 ...
StepHiDn20 (in faceplate, view „Parameter 2“, or in CFC)
Interpolation points of the step height open (X-axis: [%])
StepHiUp1 ...
StepHiUp20 (in faceplate, view „Parameter 2“, or in CFC)
Interpolation points of the response time close (Y-axis: [s])
RespDn20 (in faceplate, view „Parameter 2“, or in CFC)

RespDn1 ...

Interpolation points of the response time open (Y-axis: [s])
RespUp20 (in faceplate, view „Parameter 2“, or in CFC)

RespUp1 ...

Maximal step height for scaling of the X-axis
„Parameter 2“, or in CFC)
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC
Flow Characteristic
The flow characteristic is displayed in the faceplate, view „Flow characteristic“. The
reference flow characteristic (flow rate as a function of the valve position) is shown
for flow monitoring as a solid line (see Figure 3-5). The interpolation points of the
reference characteristic can be entered manually or teached automatically. The
scaling of the coordinate axis is done by the input variables FlowMax (flow) and
VlvPosMax and VlvPosMin (valve feedback position) in faceplate, Parameter 1“,
or in CFC. The indication of the actual characteristic learned automatically (dotted
line) can also be displayed in the diagram beside the reference characteristic. By
setting the input variable AdoptActFlow = 1 (in faceplate, view „ Flow
characteristic “, or in CFC) the actual characteristic is adopted to be the reference
characteristic. This should be done in good condition of the valve after sufficient
data have been collected in the relevant operating area of the flow such that the
current characteristic has an adequately smooth shape and covers an adequately
broad area.
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Figure 3-5: Flow characteristic, green dot: current operating point
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3 Parameter Specification and Commissioning
3.2 Parameter Input in Faceplate or CFC
Operating Point Monitoring
In order to diagnose damages inside the valve the reference flow characteristic is
compared with the actual operating point (Flow or siFlowNorm and Rbk) and the
actual characteristic learned automatically. If the deviation of the operating point
from the reference curve is within the tolerances, the operating point is green in the
diagram. Otherwise a deviation outside the tolerance limits is shown by a red
operating point (see Figure 5-3).
Deviations from the reference characteristic can be explained by a variation of the
valve cross-section. Mechanical damages and material caking inside the valve
cause deviations of the valve cross-section. These result in a different flow at the
same valve position. If the actual operating point is below the characteristic, the
actual flow is too small with respect to the valve position and there is e.g. a material
caking or blockage. If the actual operating point however is above the
characteristic, material is missing inside the valve. The reasons for this can be
material loss by abrasion, cavitation, rust or breaking of the valve cone.
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The operating point monitoring recognizes a temporary deviation of the reference
characteristic and displays both the absolute deviation (DevFlow) and the relative
deviation (RelFlow). During a violation of the maximum relative deviation
(FlowTol, in faceplate, view „tolerance“, or in CFC) the output value FlowAct is
set.
Automatic Learning of the Characteristics
The automatic learning of the characteristics is always active. The function block
monitors the different input variables and detects new steady state measurements.
These new measurements are used to obtain an actual characteristic as up-to-date
as possible. The learned flow characteristic consists of 20 interpolation points
(ActFlow1, ActVlvPos1) ... (ActFlow20, ActVlvPos20). Each interpolation point is
calculated from up to 5 measurements. The influence of single outliers and
measurement inaccuracies is reduced by this averaging.
The averaging is weighted by the actuality of the single measured values. New
measured values are weighted more heavily than obsolete values. The actuality of
the interpolation points is shown in the diagram (see Figure 3-6) by the respective
point size. Large points are a sign for high actuality of the measured values. If a
valve position was not yet reached and no corresponding measured value is
available for this point, this point is calculated by a linear interpolation of the
surrounding points. The actuality of the value and the related point size are set to
the minimum value. With the binary input variable Adopt_ActFlow =1 respectively
the button “Adopt” in view “Flow characteristic” the actual characteristic is adopted
to become the reference characteristic.
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Figure 3-6: Teaching of reference flow characteristic

If there are no interpolation points for the reference characteristic, the current
actual characteristic can be adopted to become the new reference characteristic
(Adopt_ActFlow = 1). Single interpolation points of the actual characteristic can
also be used for readjustment of the reference characteristic. If the actual
characteristic is to be learned from scratch, the current actual characteristic has to
be deleted (RstActFlowOP = 1 in CFC, or in faceplate, view „Flow characteristic“).
Drift Detection
The automatic learning of the characteristics provides the basis for long-term drift
detection. Long-term deviations can be identified this way, better than by simple
operating point monitoring. It can be decided whether the characteristic as a whole
drifts away or the behavior differs only in certain areas of the characteristic line.
The monitoring of the drift detection compares the reference characteristic with the
actual characteristic learned automatically. The function block calculates the area
between the two curves and displays the relative deviation to the reference
characteristic at the output variable DevFlow. If the deviation between the two
curves exceeds the tolerance FlowDriftTol, the output variable FlowDriftAct is
set.
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Response Time Characteristics
The response time characteristic is displayed in the faceplate, view „Response
characteristic“. The response time is the time which a valve needs to reach the
valve position setpoint. The reference response time characteristic (response time
as a function of the step height) is shown as a solid line. The interpolation points of
the reference characteristic can be entered manually or learned automatically. The
scaling of the coordinate axis is related to the input variables T_RespMax
(response time) and StepHiMax (step height) in faceplate, view „Parameter 2“, or
in CFC. The actual characteristic learned automatically (dotted line) can be
displayed in the diagram besides the reference characteristic. The response time is
also depending on the direction of valve movement. The characteristic for positive
setpoint steps can differ from the characteristic for negative setpoint steps. The
reason is that valves are typically moved in one direction by compressed air and in
the other direction by spring force. These two drive systems react differently to
faults and valve damages. The response times for opening and closing are
therefore included in separate characteristics.
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NOTE

The function block recognizes only real setpoint steps, no other signal forms,
such that the response time monitoring does not provide any meaningful results
if monitoring a valve operated by a flow controller in automatic mode.

Figure 3-7: Response time characteristic
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Operating Point Monitoring:
In order to diagnose damages of the valve drive or friction problems in the
valve sealing the reference response time characteristic is compared to the
actual operating point (StepHiDn, T_RespDn for closing and
StepHiUp,TRespUp for opening) and an actual characteristic learned
automatically. If the deviation of the operating point from the reference curve is
within the tolerances, the operation point is green in the diagram. Otherwise a
deviation outside the tolerance limit is shown by a red operating point.
A slow valve movement results in a large response time since the valve needs
a long time to reach the end position. An increasing response time can be an
indicator of increased friction inside the valve. Moreover, a leakage of the
compressed air supply results in slowing down valve movements. A damage of
the valve drive can also be a reason for deviations of valve response time.
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The operating point monitoring recognizes a temporary deviation of the
reference characteristic and displays both the absolute deviation (DevRespDn
and DevRespUP) and the relative deviation (RelRespDn and RelRespUp).
During a violation of the maximum relative deviation (MoveTol, in faceplate,
view „tolerance“, or in CFC) the output value RespDnAct and RespUpAct is
set.
Automatic Learning of the Characteristic:
The automatic learning of the characteristic is always active. The function block
monitors the different input variables and detects new steady state
measurements. These new measurements provide the data to obtain a
characteristic as up-to-date as possible. The response time characteristic
learned automatically consists of 15 interpolation points (ActStepHiDn1,
ActRespDn1)... (ActStepHiDn20, ActRespDn20) and (ActStepHiUp1,
ActRespUp1)... (ActStepHiUp20, ActRespUp20). Each interpolation point is
formed from up to 5 measurements. The influence of single outliers and
measurement inaccuracies is reduced by this averaging.
The averaging is weighted by the actuality of the single measured values. New
measured values are weighted more heavily than obsolete values. The
actuality of the interpolation points is shown in the diagram by the related point
size. Large points are a sign of a high actuality of the measured values. If a
certain setpoint step height was not yet observed and no corresponding
measured values are available for this point, this point is calculated by linear
interpolation from the surrounding points. The actuality of the value and the
related point size are set to the minimum value.
If there are no interpolation points for the reference characteristic, the current
actual characteristic can be adopted to be the new reference characteristic
(Adopt_ActResp = 1 in CFC, or in faceplate view „Response characteristic“).
Single interpolation points of the actual characteristic can also be used for
readjustment of the reference characteristic. If the actual characteristic is to be
learned from scratch, the current actual characteristic has to be deleted
(ActRespReset = 1, in faceplate, view „Response characteristic“, or in CFC).
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Deadtime:
The deadtime is also an important parameter of the valve movement, besides
the response time. The dead time is the time which the valve needs to get into
movement. If the dead time increases, this is an indicator of material caking or
stiffness of the valve. For the measuring of the dead time a tolerance range
(DeadTol, in faceplate, view „Tolerance“, or in CFC) is defined around the
actual valve position. If the position setpoint changes, a timer is started. The
timer measures the time which passes until the valve position has left the dead
zone (DeadTolOut). If the deadtime exceeds the tolerance band, the output
variable DeadAct is set. (Available in a later version).
Control Error:
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If the valve has completed its movement, the final position is compared to the
reference position. The difference is the steady state control error. A remaining
error indicates problems with the drive, with the supply energy or a mechanical
damage. If the control error exceeds the tolerance band (FinalPos, in
faceplate, view „Tolerance“, or in CFC), the output variable CtrlDevMaxAct is
set.
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3.2.4

Histograms
The histograms visualize the frequency distribution of the different valve positions
or step heights over the complete valve position range (0...100%) as a bar chart.
The range is divided into ten bars, each of which represents one 10% interval, i.e.
the valve position range (X-axis) is subdivided into 10 part sections equal in size.
Every part section has a counter of its own. The first part section e.g. represents
the valve positions of 0...10%.
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Figure 3-8: Histograms

The total time T_HisPos is counted using the sampling time and is displayed as
recording time in [h]. If the input variable RstHisOp =1 (in faceplate, view
„Histogram“, or in CFC) is set, all counters and the total time T_HisPos are reset to
zero and restarted.
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Histogram for Valve Position
This histogram visualizes the frequency distribution of the different valve positions
over the complete valve movement range.
The single counter values per part section are incremented depending on valve
position value. They indicate the operating time of the component inside the part
sections in % (HisPos0...HisPos10).
Evaluation of the histogram:
Valves should be operated mostly in the medium range (10...90 %) of possible
valve positions, and not at the edges close to start and end position.
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If there are significant accumulations in the range of very small valve openings,
the valve is oversized. In the range of very small valve openings the valve
characteristic is not reproducible. Process control is difficult here, and there is
the danger of cavitation. In addition, a valve almost completely closed will
cause stronger pressure losses because of flow redirection and flow through
narrow openings.
If there are significantly accumulations in the range of very big valve openings,
the valve is undersized (too small in dimension). A flow controller which relies
on such a valve has hardly space to move upwards with its controlled variable,
which slows down positive set point steps. If the valve in the fully open position
has a smaller cross-section than the pipe, there are turbulences and pressure
losses at the junction point.

Histogram Step Height
This histogram visualizes the frequency distribution of the different step heights
over the complete valve movement area.
The single counter values per part section are incremented depending on step
height. They indicate the operating time of the component for the partial sections in
% (HisStepHiDn1... HisStepHiDn10 und HisStepHiUp1... HisStepHiUp10).
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4

Evaluation for Plant Asset Management
Different results of the calculations performed by VlvMon are relevant for different
target groups working in a process plant, and differ with respect to urgency.
Diagnoses like actual valve blockade or compressed air leakage have to be
immediately announced as an alarm to the operator, because in such operating
conditions the valve is not available for process control.
Other operating conditions like e.g. deviations of the upper and lower end position
or the detecting of a steady state control error after the end of the valve move
represent only a smaller impairment of process control or will result in valve
damage after some longer time.
Hints to deviations of the actual operating point from the reference characteristic do
not inevitably indicate a mechanical damage of the valve.
Following these considerations, it is reasonable to evaluate the information created
by VlvMon in a target group oriented way.
The VlvMon function block does not include its own messaging.
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Warnings and alarms for the operator can be created using the binary output
signals of VlvMon. If possible, these output signals are linked to free binary
message input variables of the assigned technological function block (e.g. of the
VlvAnL function block or flow controller). Otherwise separate Event or MonD
function blocks are inserted in the CFC and linked with these.
Maintenance request messages are created according to section 4.3 by the related
AssetMon function block.

4.1

Evaluation with Fault Symptom Trees
Different faults which are shown in black in Figure 4-1 can occur in a control valve.
These faults lead to observable symptoms via physical cause-effect relationships
which can be detected by VlvMon function block. The fault trees help you to
conclude the underlying fault causes from the symptoms observed.

Figure 4-1: Fault tree of flow characteristic and end positions
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If you recognize a deviation of the reference characteristic in the VlvMon faceplate,
you can distinguish whether the deviation extends over a large range of the
characteristic or only a small part.
If the deviation is only local and appears only temporarily, it is completely harmless.
Since the characteristic only describes the behaviour of the valve in steady state,
temporary deviations can appear during transients e.g. after a setpoint step.
Only if a deviation of the actual operating point from the reference characteristic is
present for some time, a message is triggered. Permanent deviations which appear
only in a certain region of the characteristic line indicate locally restricted damages
to valve body or valve seat which have an effect only at certain valve positions.
If the actual characteristic differs from the reference characteristic over a wide
range, this is called a characteristic drift, which should be reported to the operator
or better to the maintenance personal in any case. Different cases have to be
distinguished.
If the flow rate is far too high, i.e. the flow rate lies far above the reference
characteristic, it has to be assumed that the valve cone is torn off.
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If the actual characteristic of the flow is located a little above the reference
characteristic, then the valve cross-section is larger than in good condition of the
valve. A material loss inside the valve therefore has to be suspected, caused by
abrasion, cavitation or rust.
If the actual characteristic is located below the reference characteristic, the flow
rate is lower than expected, i.e. the valve cross-section is smaller than in good
condition of the valve. Reasons for this can be material caking at the valve body or
the valve seat or a blockage by foreign particles.
Sometimes faults like material caking, foreign particle or abrasion can be detected
also without characteristic line monitoring, if the valve is driven to the upper or
lower end position. If the upper or lower final position cannot be reached any more,
i.e. the valve drives upwards only to 99% or downwards only to 1% for example,
material caking or a foreign particle has to be suspected.
If the valve drives upwards over or downwards below the final positions measured
in good condition, e.g. reaches feedback positions of less than 0% or larger than
100%, the reason can be material loss.
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Figure 4-2: Fault tree of valve movement
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friction of
packed gland
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material caking

If a valve responds too slowly to setpoint steps, i.e. the actual characteristic of the
valve response time is located above the reference characteristic, or the dead time
which the valve needs to leave its rest-position after a setpoint command is too
long, you should check the compressed air supply in any case. Even if the valve
moves "by itself", i.e. leaves its position without a setpoint command, just due to
the force executed by the medium to the valve body, it makes sense to check the
compressed air supply. Otherwise a movement without setpoint command is only
possible if the mechanical connection between drive and valve body has loosened.
If the compressed air supply pressure is too low, leakages in the pneumatic
pipeline system or problems of the compressed air production by the compressor
are considered as problem causes.
If however the pneumatics pressure is sufficient, stiffness of the armature or a real
defect of the drive is considered as a reason for too slow valve dynamics. Stiffness
can be caused both by static friction in the packing gland (seal) of the valve and by
material caking at mobile parts.
If a remaining deviation is watched at the valve position, because the feedback
position does not reach the setpoint position or there is a continuous oscillation of
the position controller, then friction effects or defects of the drive also can be the
causes. A wrong parameter setting of the internal position controller also belongs
to "defects" of the drive in this context.
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4.2

Evaluation of the Histograms
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Figure 4-3: Evaluation of the histogram for the valve positions
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The graphical representation corresponds to the description in section 3.2.4.

4.3

Maintenance Request
A maintenance request announced by a maintenance message is not generated by
the VlvMon function block itself, but by the associated AssetMon function block.
The AssetMon is a universal proxy function block for mechanic and process assets
in the Maintenance Station of SIMATIC PCS 7. The AssetMon block can be
replaced by the newer AssetM block from the AP library. The AssetM faceplate is
designed according to APL style. In the following only the AssetM is mentioned. It
is located in the hierarchy folder of the Maintenance Station and not in the normal
plant hierarchy. Its faceplate therefore appears in the Maintenance Station and not
in the Operator Station.
The Electronic Device Description (EDD) containing the master data of the control
valve is attached to the AssetM block, allowing accessing the valve like an
intelligent field device in the context of asset management.

4.3.1

Specification of Control Valve Master Data
In order to generate the EDD for a valve, you need a so called PLT-ID. The PLT-ID
is a connection parameter between a PDM object (parameter data EDD) and the
faceplate in the maintenance station. The PLT-ID is linked to the PDM object.
The PDM object is generated in the SIMATIC Manager as follows:
1. Select “View > Process device plant view” in SIMATIC Manager.
2. Select “Insert > SIMATIC PDM > TAG”.
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3. Highlight the inserted TAG object and select the context menu command
“SIMATIC PDM > Device Selection..”.
4. Select “CFC > DATA_OBJECTS > CFC > AssetM” in the tree structure and
close the dialog with "OK".
5. In the context menu select “Open Object” and enter all necessary data in the
parameter assignment screen form.
6. Select “File > Save”. The parameter assignment screen form is closed.
7. Select the TAG object and then Tools > SIMATIC PDM > Create PLT-ID.
You can then assign parameters for the PLT-ID generated automatically at the
associated parameter "PLT_ID", view: Details.

NOTE

The PLT-IDs cannot be changed or deleted individually.

Now maintenance requests and master data of the control valve are displayed
together to maintenance personal.
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4.3.2

Linking and Parameterization of AssetM Function Block
After a defined maximal number of strokes resp. shifts of direction the valve needs
maintenance in any case. From the output variable VlvMon.Strokes resp.
VlvMon.SID of the VlvMon function block, you can take the overall number of
strokes resp. shifts of direction. You have to link these output variables to the
analog input variable PV1 resp. PV2 of the AssetM function block.
Define the limits for Maintenance Request PV1_RH resp. PV2_RH, Maintenance
Demand PV1_DH resp. PV2_DH and Maintenance Alarm PV1_AH resp. PV2_AH
such that after the specified number of strokes resp. shifts in direction the desired
maintenance request is generated.
The AssetM function block additionally provides seven message input variables
(Message1 … Message7), which generate an alarm by setting the variable to 1.
For a maintenance request the message input variable Message2 can be used. A
maintenance request is e.g. a limit violation of the maximal relative deviation of the
actual flow characteristic from the reference flow characteristic. Then the output
variable VlvMon.FlowAct has to be linked with the input variable Message2 of the
AssetM function block. If further binary outputs of VlvMon function block have to be
considered, all outputs have to be linked with an OR-function block and the result
with the input variable Message2.
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Figure 4-4: Linking of AssetM function block for a control valve
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5

Application Example
There is a PCS7 solution template for automation of a pump unit in literature /2/.
The pump unit allows generating a controlled flow using a fixed speed pump. Valve
monitoring is implemented into this solution template.
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Figure 5-1: PCS 7 solution template pump unit

The PumpUnit is extended with the following additional functions and the related
measurement tag instances:
Valve monitoring using the VlvMon function block.
Pressure sensor installed at valve outlet.
Detecting steady states for learning of the flow and response time
characteristics using the SteadyState function block.
Optional: Pressure sensor for monitoring the compressed air supply of the
valve.
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The reference state of a valve is represented in the following figure. There are no
drifts away from characteristic lines to be watched. All the operating points are on
the reference flow characteristic.
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Figure 5-2: Flow characteristic in reference state of valve
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In the following figure a drift can be recognized. The actual characteristic is below
the reference characteristic. Reasons for this can be material caking at valve body
or blockage.
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Figure 5-3: Material caking at valve body
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In the next figure a drift can be seen as well. The actual characteristic is above the
reference characteristic. It has to be assumed that there is material loss inside the
valve, in worst case the valve cone is torn off.
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Figure 5-4: Material loss inside the valve
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The next figure shows a strong variance of the values learned for the response
time characteristic. A dependency of response time on initial valve position was
observed in this case. In this case an evaluation of the response time characteristic
is pointless.
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Figure 5-5: Strong variation of actual response time values

ValveMonitoring
Entry-ID: 87604493,

V1.0,

02/2014

36

6 Summary

6

Summary
The following table shows the correlation of measurable process variables and
detectable problems.

Table 6-1: Diagnostics
Flow

Pressure
difference
across valve

Valve position
setpoint

Hours without movement

x

Hours without standstill

x

Number of strokes

x

Shifts in direction

x

External movement

x
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Exceeded upper / lower end
position

Valve position
feedback

x
x

Response time characteristic

x

x

Control error

x

x

Dead time

x

x

Flow characteristic

x

x

x

Histogram valve feedback

x

Histogram Step height

x

Legend:
x: Measurement required (mandatory)
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